**Novel Design of a Three-Dimensional Biomimetic Nanofiber Scaffold: Applications in Ligament Tissue Engineering**

John Schoenbeck*, Chris Lach*, Reem Daher-Nahhas*
Advisors: Tristan Maerz**, Dr. Yawen Li*
BME 4022 – Projects II – Dr. Mansoor Nasir*, Spring 2013 Final Thesis
*Lawrence Technological University Biomedical Engineering Program
**Orthopedic Research Laboratories, Beaumont Health Systems

**Abstract:** The anterior cruciate ligament of the knee is a commonly injured tissue in young athletes. These injuries are strongly correlated to the latent onset of osteoarthritis, and total joint replacements are not an ideal solution for non-senior patients. Surgical reconstruction of this ligament using autologous tendon grafts have been largely successful, but are limited by differences between tendon and ligament tissues and a high degree of harvest-site morbidity. Tissue engineering has the potential to eliminate these limitations, and a biomimetic design philosophy greatly enhances cellular synthesis of an extracellular matrix. Current literature is hindered by incongruities between publications that make comparisons to novel designs challenging. In this research, a second-order triple helix design that mimics the hierarchal structure of ligament matrices was made from electrospun poly(ε-caprolactone) and characterized using a novel set of protocols that quickly characterize the scaffold’s structure, mechanical properties, and cellular biocompatibility with human fibroblasts. Experimental results determine that this design is consistent and repeatable; and accurately mimics the architecture and mechanical properties of the native tissue. Biocompatibility results show positive outcomes, but have some non-ideal qualities that will be adjusted to improve the separations of the sample data from controls.

**Table of Contents:**

<table>
<thead>
<tr>
<th>Section 1: Senior Capstone Project Final Report…………..</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction………………………………………………….</td>
<td>2</td>
</tr>
<tr>
<td>2. Materials &amp; Methods………………………………………..</td>
<td>7</td>
</tr>
<tr>
<td>3. Results &amp; Discussion………………………………………..</td>
<td>10</td>
</tr>
<tr>
<td>4. Conclusions………………………………………………….</td>
<td>15</td>
</tr>
<tr>
<td>5. Acknowledgements…………………………………………</td>
<td>15</td>
</tr>
<tr>
<td>6. References………………………………………………….</td>
<td>16</td>
</tr>
<tr>
<td>Appendix A: Protocols Archive………………………………</td>
<td>18</td>
</tr>
<tr>
<td>Appendix B: Data &amp; Images Archive………………………..</td>
<td>28</td>
</tr>
<tr>
<td>Section 2: BME Senior Capstone Project Milestones……..</td>
<td>111</td>
</tr>
</tbody>
</table>
1. **Introduction:** The anterior cruciate ligament (ACL) is an important tissue found within the knee capsule formed by the distal femur, proximal tibia, and patella. The ligament is attached on one end to the distal femoral notch, and fans out to an elongated attachment region along the intercondylar eminence of the tibia (figure 1). The ACL functions to resist anterior drawer and medial rotation of the tibia as it slides along the femoral condyle during walking, running, and jump landing motions. Non-contact injury mechanisms such as sharp cutting movements and lateral jump landings result in a high incidence of partial and complete ACL ruptures in young athletes, with women at a significantly higher risk than men \(^{[1]}[2]\). Despite the relative success of revision surgery, ACL injuries are strongly correlated to latent onset of osteoarthritis (OA) of the knee \(^{[3]}\). Due to the young age at which these injuries occur and the high likelihood of developing OA, patients face the potential need for a knee replacement by the time they are middle-aged, which guarantees the need for revision knee surgery when they are seniors and the first prosthetic reaches the end of its useful lifespan \(^{[4]}\). Several effectors of latent onset OA as a result of knee injuries have been explored by researchers in orthopedics-related fields. One of the possible causes is traumatic death of chondrocytes and osteocytes that are responsible for maintaining the bone and cartilage tissues that make up the knee joint \(^{[5]}\). The second scenario is death of the same cells as a result of improper loading mechanisms following an ACL injury \(^{[6]}\). Patients who do not opt for replacement surgery learn to avoid certain movements that cause joint instability, but the occasional mistake would cause extreme friction and stress concentrations at the tibiofemoral interface that leads to chondrocyte death and degeneration of the cartilage. This risk for cyclical micro damage to the cartilage from the lack of a functioning ACL can be significantly reduced by performing an ACL graft replacement operation.

ACL reconstruction surgery has seen several advances since it was first performed in 1917 \(^{[7]}\). Today’s surgeons have a couple of options, and the gold standard for ACL reconstruction is to use a tendon autograft. Autografts (donor is the recipient) are the preferred choice for replacement tissues because they greatly reduce the risks of interspecies disease transmission and non-self immune response typical with xenografts (non-human donor) and allografts (human donor), respectively \(^{[8]}\). This preference comes with a primary limitation: ligaments are extremely important tissues in joint stability and patient mobility, and cannot be grafted to produce a new ACL as removal from its original location would only lead to mobility and degenerative issues at the harvest site. Surgeons overcome this issue by replacing the ligament with a tendon graft. Depending on the lifestyle needs of the patient the surgeon can reconstruct the ACL using a double-layered semitendinosus and gracilis (DLSTG) tendon graft.
or a bone-patellar tendon-bone (BPTB) graft\(^9\). Both of these grafts require causing an additional injury to the patient that can lead to both temporary and permanent limited mobility and in increased risk of infection at the harvest site. These surgeries have an 80 to 90% rate of success, but have not been shown to reduce the risk of latent OA\(^3\). It is suspected that this is due in part to the fact that tendons and ligaments, despite their similar compositions, have very different functional properties. Tendons are stiffer than ligaments and are composed of thick, straight collagen fibers that are optimized for uniaxial tension. This linearity and rigidity help to optimize muscle function to push or pull on the bones that are connected to them by the tendon. Ligaments, however, attach bone to bone and are composed of crimped, wavy arrangements of collagen that act to stabilize the joint against dynamic movements with multiple degrees of freedom\(^{10}\). The body compensates for this difference in properties by remodeling the tendon graft into ligament tissue, but the time for this process to occur is over 6 months\(^{11}\). During this ligamentization phase, the tendon may over-stabilize the joint and result in the same increases in friction and stress concentration that causes chondrocyte death and degeneration of the cartilage. Since ligaments can’t be harvested for ACL reconstruction and tendons carry inherent risks, there is a significant need for the development of ligament tissues that can be grown from autologous cells \textit{in-vitro} and used for more ideal reconstruction grafts.

Tissue Engineering (figure 2) is a specialized field of biomedical research that is beginning to revolutionize the process of surgical restorations across a variety of applications. Perhaps one of the most important organs, skin, can be grown in a laboratory using a small sample of the graft recipient’s own cells\(^{12}\). The potential for artificially reproducing autologous (the donor is also the recipient) tissues from expanded stem cells and primary cells is the most attractive feature of this type of work. Thinking futuristically, a patient suffering from renal failure would not have to be anxious about moving up a donor list if he can go to the hospital for a small biopsy and return several weeks later to receive a new copy of his own kidney. Autoimmune rejection is reduced only to a small response to the materials used to make the patient’s cells take the shape of the organ. That condition is temporary, however, as that structure or ‘scaffold’ would be made from biodegradable materials; eventually, the scaffold will be removed by the body as the new tissue heals into place. Current research, like that presented here, is focused on attempting to make new tissues of a specific type (One must be able to produce working renal tissue before hoping to produce a whole kidney). Skin has been successful, but researchers must focus on several other commonly injured tissues, most importantly those tissues that are known to have extremely low healing rates such as ligaments\(^{13}\).
There is a wide spectrum of tissue engineering related work with regards to ligament replacement tissues. Stem cells that have been isolated and differentiated into fibroblasts, and fibroblasts directly expanded from an existing line of patient cells are both potential candidates for engineered ligament tissues (figure 3) [14]. These cells tend to align with microfeatures on the surface they attach to, and then produce a large variety of tissues based on the environmental conditions that they experience (i.e. tendon/ligament tissue when fibroblasts are stretched axially, and vascular tissue when stretched longitudinally) [15]. Several materials, both natural and synthetic, have been used in attempts to find those that work best for producing ligaments [16]. Electrospun nanofibers, which involve ejecting liquid polymer through a high voltage nozzle and collecting the drying product on a high-speed mandrel, have been proven to fulfill this purpose with an enhanced cell response when compared to films of similar polymer types [17]. Several biodegradable polymers are available to use with this material fabrication method, and Poly(ε-caprolactone, PCL) shows exceptionally good stability and degradation rates for use in ligament tissue engineering (figure 4) [18]. Cyclic axial tension with a small amount of twisting motion seems to stimulate fibroblasts into producing ligamentous collagen matrices [19].

The extracellular matrix (ECM), which is comprised mostly of collagen in ligaments, is a crucial point of scientific studies related to qualifying lab produced tissues for use in surgical replacement therapies [20]. A successful tissue surrogate should have an ECM structure and composition that matches the native tissue it is intended to replace [16]. Major considerations for engineers in this area are differences between cells growing in a laboratory environment and those present in the native tissue [17]. These differences are typically the primary obstacles faced in current tissue engineering research. The current hurdle for ligament tissue engineers is trying to figure out how to get fibroblasts or stem cells that are seeded onto a scaffold to produce a thicker, stronger ECM within a reasonable growth period. While ligament tissues can be elicited from seeded fibroblasts via appropriate cell selection and stimulation, these ligaments do not approach the necessary mechanical properties of the native tissue that will allow it to serve as an ideal replacement for something as important for a patient’s mobility such as an ACL [21].

There is a wide array of cells to choose from and a well-documented system for mechanical and chemical stimulation factors that produce better ligament tissues [21]. A biomedical engineer wanting to overcome the current hurdles may wish to turn to the one
variable left with a lot of room for improvement: the biomaterial scaffold. Tissue engineering scaffolds typically follow a universal design philosophy called biomimetics [22]. Biomimetics refers to the same idea as trying to match properties of the native ECM, but covers a much more extensive array of properties. Basically, any scaffold fabrication or cell stimulation technique that both resembles the cells’ native environment and improves productivity in the laboratory falls into the category of biomimetics [22]. Cells are extremely complicated entities, and respond in a rather volatile way to changes in their environment. This feature of cell growth demands is what makes biomimetics an important problem-solving tool for tissue engineers. By finding novel ways to achieve a biomimetic approach, significant improvements to the current state of the art in engineered tissues of all types can be made.

The first milestone one must achieve in scaffold design is an appropriate living space for the cells intended to be seeded onto the matrix. Pore sizes of 150 to 250 micrometers in diameter tend to be ideal for encouraging cell migration and proliferation in-vitro [23]. Another important characteristic to consider with cells is mechanical environment. Cells will not only respond in various ways to the intensity of mechanical stimulation applied to the entire tissue graft, but also to the mechanical properties of the material surface they grow on [24]. A scaffold that has all of the best possible properties for a particular tissue type but perhaps is a bit too stretchy can severely hinder the viability of the engineered tissue. Mechanical stimulation is also to be considered; the successful scaffold must not only possess the appropriate local mechanical conditions to encourage a better response, but must also be able to handle the dynamic conditions of the native tissue environment.

The specific biomimetic approach chosen for this research is to imitate the triple helix hierarchal structure of collagen (figure 5). The triple helix formed by natural collagen molecules gives rise to a special property of ligaments known as the toe region [23]. The toe region refers to a non-linear structural property that allows a material to stretch a certain distance without a linear increase in material strain. In native ligaments, the toe region is produced by the tendency of collagen fibril helices to form a crimped, wavy macrostructure. Increasing stress causes the collagen bundles to straighten, allowing the ligament to stretch some distance before the collagen fibrils experience any increase in strain [25]. By assembling scaffold material fibers with a triple helix structure, the toe region of the scaffold can more accurately mimic the toe region of the native ligament while maintaining the other factors of biocompatibility previously mentioned.

Characterization of newly designed ligament scaffolds varies greatly from researcher to researcher. Scientists involved in tissue engineered ligaments test their scaffold materials and designs by seeding them with cells and testing them at several time points for appropriate gene expressions that indicate differentiation into fibroblasts and/or collagen synthesis [15][26][27]. Engineers, on the other hand, tend to lean towards testing several mechanical properties of their
materials to determine how well the scaffold mimics the functionality of the native ECM\cite{13}\cite{28}\cite{29}. Between the two respective fields, some researchers conduct a thorough analysis of their proposed architecture to make it reproducible, while others only briefly outline the process\cite{17}\cite{30}. Both fields have advantages and disadvantages when compared to one another\cite{14}. Cellular analysis ensures that the scaffold material interacts appropriately with its biological components but requires 40 day long cultures and a complicated array of controls such as growth media, cell source, and validation of cellular analysis methods. Mechanical testing of scaffolds can be done in a matter of days given the right equipment and an unlimited supply of raw materials, but the best matched mechanical function is worthless if the material is toxic to the cells and the patient. In this research, we propose to develop a rational set of protocols that combine analysis methods for structure, mechanical properties, and biocompatibility that will focus on key parameters for the rapid (<20 days) characterization of ligament tissue engineering scaffolds. These protocols will allow researchers to test both the functionality and compatibility of their scaffold, and return to the design phase if necessary with a minimized amount of wasted time.

Establishing a set of key properties requires careful consideration of the multifaceted aspects of materials, chemicals, and cells that are involved in the characterization of a working ligament tissue engineering design. To draw the focus of these studies towards the characterization of the scaffold, the cells and stimulation need to be uniform and easy to work with. Human periodontal ligament fibroblasts work well for this purpose because they are already differentiated to the appropriate phenotype and have a short doubling time. Phosphate buffered saline and standard growth media with serum and mild antibiotics should be used for all culture and assay studies. Biocompatibility assays that are simple and effective in static cultures eliminate the need for complicated and expensive bioreactor chambers, which can be left for long-term characterizations if the short-term experiments support the scaffold design. Mechanical properties are expansive, and should be focused on preliminary analysis of the functional properties and local cellular environmental factors\cite{24}. Ultimate strengths and maximum strain are indicative of the scaffold’s ability to handle both mechanical stimulation in-vitro and loading in-vivo, while the toe region and elastic modulus are properties that represent local environmental cues for the fibroblast cells\cite{31}. All four of these properties can be gleaned from a uniaxial tension failure test if the cross-sectional area of the fibers can be accurately estimated. To ensure the architecture of the scaffold is repeatable and ideal for ligament tissue engineering, braiding should be conducted with a load cell and video recording to establish braid angle and tension. Scanning electron microscopy works effectively at measuring the sizes of the pore openings and comparing the braided fiber structure to that of ligament collagen fibers.

With these fundamental concepts and key properties in mind, we propose two hypotheses toward improving the approaches of ligament tissue engineering. First, we hypothesize that a biomimetic scaffold structure that mimics the crimped/wavy extracellular matrix architecture of native ligaments will promote fibroblast attachment, alignment, and metabolic activity. In addition, we propose that a set of characterization protocols that focus on essential structural,
mechanical, and cellular biocompatibility properties will allow for a more rational approach to designing and characterizing ligament tissue engineering scaffolds. If these characterization methods are used as a standard protocol for tissue engineers, it will enable all parties to directly compare their own designs to those established by previous researchers. Table 1 contains the key properties we selected based on an extensive review of scaffold design literature, and lists the properties of the native ACL with the best results achieved by literature to date.

<table>
<thead>
<tr>
<th>Research Goals</th>
<th>Parameter of Interest</th>
<th>Native Tissue Properties</th>
<th>ACL Scaffold Data from Literature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomimetic Structure</td>
<td>Braid Angle</td>
<td>N/A</td>
<td>30-33 degrees</td>
</tr>
<tr>
<td></td>
<td>Braiding Tension</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Fiber patterns</td>
<td>Aligned &amp; Crimped</td>
<td>Circular Loom</td>
</tr>
<tr>
<td></td>
<td>Porosity</td>
<td>N/A</td>
<td>55% to 65%</td>
</tr>
<tr>
<td></td>
<td>Pore Size</td>
<td>N/A</td>
<td>150 to 250 um</td>
</tr>
<tr>
<td>Mechanical Properties</td>
<td>Ultimate Tensile</td>
<td>13 to 46 MPa</td>
<td>46 MPa</td>
</tr>
<tr>
<td></td>
<td>Strength</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Elastic Modulus</td>
<td>182-292 MPa</td>
<td>150 to 200 MPa</td>
</tr>
<tr>
<td></td>
<td>Maximum Strain</td>
<td>30 to 44%</td>
<td>32%</td>
</tr>
<tr>
<td></td>
<td>Toe Region</td>
<td>2 to 4.8%</td>
<td>Up to 7.5%</td>
</tr>
<tr>
<td>Biocompatibility</td>
<td>Cell Alignment</td>
<td>Parallel to Strain</td>
<td>Parallel to Fiber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Axis</td>
<td>Axis</td>
</tr>
<tr>
<td></td>
<td>Cell Viability</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Table 1: Key properties for the characterization of tissue engineered ligament scaffolds and comparison to native tissues and data from literature.
2. Materials & Methods: For a detailed list of equipment and steps, see the LTE protocols archive (Appendix A). These protocols describe the methods used for one two-week data collection block. Successful trials within six blocks of data were used in the final analysis of the results.

2.1 Scaffold Preparation

Nine, one-meter long stock samples of electrospun poly(ε-caprolactone, PCL) nanofibers were cut into three equal sections and fixed to a custom-built tension measurement clamp guide. The clamp and roller setup was attached by a string to an iLoad Loadstar-F tension adapter and elevated at one end to overcome static friction. The cell was zeroed and a Nikon J1 camera was mounted to an observation platform directly over the fiber braiding area. Three strips of fiber were braided into a triple helix while the braiding tension and angle measurement data were collected throughout the process. The subunits were then braided into a second triple helix to form the nine-fiber second-order triple helix scaffold architecture. String was used to tie the ends of the subunits and final braid samples at the end of each braiding trial. Load cell data was then exported Microsoft Excel for signal averaging and calculations of the mean and standard deviation of each braid’s tension. A freeware motion-analysis software program titled Kinovea was used to key frame and determine average twist angle measurements from ten data frames for each braid.

2.2 Structural Analysis and Small Sample Division

Full-length braid samples were scanned in 10 randomly spaced areas and two to three pore opening measurements were made using a Quanta FEG 450 environmental scanning electron microscope (ESEM). SEM Images were compared to web-archived SEM images of ligament collagen for structural observations. Samples were cut for three MTS, three CT/porosimetry, and eighteen biocompatibility trials for each block. Clean data from six blocks were used for n totals of 11, 6, and 40 in final analysis of the results. Samples were cut by tying two pieces of sewing thread about 1.5 mm apart and cutting between them.

2.3 Nano-Computed Tomography & Porosimetry Data Collection

Two ~3cm samples of braided fiber scaffolds were scanned at the University of Michigan using a GE Phoenix Nanotom S nCT scanner. Raw DICOM axial slice files were filtered for noise and out-of-plane artifacts using Image J freeware. The filtered slices were reduced to binary and particle analysis was used to find the total cross sectional area of the braided fiber sample. The same samples were then shipped to Dr. Hongjie Wang, who took them to the Tsinghua University to run porosimetry analysis. Data from the porosimeter was analyzed for mean pore size, pore size distribution, and mean surface area.
2.4 Tensile & 5% Stress/Relaxation Materials Test.

Three ~6cm samples of braided fiber scaffolds were mounted to an Insight electromechanical materials testing system by wrapping the ends around a metal rod and gluing the wrapped rods to a glass slide. The rod and slide were inserted into clamp jaws on either end. A 5kN load cell was used to collect load information while the stress-relaxation and tensile failure tests were conducted. Two samples were stretched to 5% strain and held for 5 minutes before contraction to the original length. After stress-relaxation, the scaffolds were subjected to a tensile failure test at a 25% per second strain rate. Cross sectional area measurements averaged from ten CT axial slices per sample were used to calculate the normalized engineering stress/strain curves from the MTS force/elongation data in Excel. Results were analyzed by comparison to data from literature on the mechanical properties of similar braided nanofiber structures.

2.5 Stock Cell Culture

Human periodontal ligament fibroblasts were cultured to confluence in 100mm stock culture plates in standard Dulbecco’s Modified Eagle Medium (DMEM) with 10% Fetal Bovine Serum (FBS) and 1% Penicillin/Streptomycin (Pen/Strep). Cultures were incubated in a Heracell incubator at 37°C with 5% CO2 and 95% Humidity. Warmed up cells were trypsinized and 100,000 cells were seeded onto the stock plates with 10ml of media. Media was exchanged at 24 hours, then every 2 to 3 days until they reached confluence. Confluent stock dishes were trypsinized and seeded onto the fiber scaffolds as described below, while 100,000 cells were seeded onto a new 100mm plate to continue the stock culture for the next block of data collection.

2.6 Sample Seeding & Culture

49.5 grams of Polydimethylsiloxane (PDMS) silicone elastomer was mixed at a 10:1 pre-polymer to crosslinking agent ratio and poured into four 35mm culture plates. The plates were degassed for one hour in a Bel-Art dessicator, and six 50 mm x 150 mm x 300 mm Plexiglas tabs were evenly spaced and inserted into the polymer to form small rectangular channels. The PDMS was cured overnight in a 65°C Lindberg Blue M furnace and the Plexiglas tabs were removed to complete the cell seeding vehicles. Three vehicle plates, 12 ~1cm braid samples, and 6 ~1cm fiber control samples were sterilized for two hours in 70% ethanol then dried for 30 minutes before seeding. Four samples and two controls were placed in separate channels in each of the three plates, and 100,000 cells suspended in 0.5ml of media were pipetted into the channels. After 24 hours, samples were transferred using sterile tweezers into separate wells of a 24 well culture plate and cultured using the same methods described above with a media volume of 750μL per well. Biocompatibility experiments consisting of live/dead fluorescent imaging and AlamarBlue proliferation assays were conducted at day one, seven, and fourteen in static culture.
2.7 Fluorescent Cell Imaging

Cell growth and migration was monitored by Live/Dead assay at 1 day, 7 days, and 14 days in culture. Imaged braid and control samples were stained by incubation in a solution of Invitrogen Calcein AM and Ethidium Homodimer-1 for 15 minutes before temporary mounting on glass cover slips. Fluorescent images of the stained samples were analyzed to determine if intended cell niches resulted in higher concentrations of cells in those regions of the scaffold. Cell density and populations were compared with fluorescent images of single fiber controls using the same staining protocols.

2.8 Cell Proliferation Assay

At 1, 7, and 14 days in culture, cell proliferation assays using AlamarBlue were conducted to determine the metabolic activity of the seeded samples. DMEM with 10% FBS and 1% Pen/Strep was vortexed with the AlamarBlue stock reagent at a 10:1 volume ratio and 750μL of the well-mixed solution was pipetted into fourteen wells of a 24 well plate. For each time point, eight samples and four controls were transferred to the AlamarBlue plate, with the remaining two wells used as negative controls. The AlamarBlue plate was then incubated in the Heracell with the above settings for six hours. After incubation, 150μl aliquots were transferred to twenty-eight wells of an absorbance and fluorescence plate for a total of fourteen samples and technical replicates per plate. Standard curves using plate-seeded cell counts of 20, 50, and 100 thousand were collected and analyzed for each week. Absorbance readings were taken using a Molecular Devices plate reader at both 570 nm and 600 nm wavelengths. Fluorescence readings used the same setup in a black reading plate with excitation at 545nm and emission at 590nm. Statistical significance was determined by single-factor Anova tests.

3. Results & Discussion:

3.1 Biomimetic Structure:

Load cell readings were filtered for start and end time points, and all tension measurements from each braiding trial were averaged to determine the applied tension. The 50lb load cell showed a linear increase in the peak tension, while the low tension reading was consistent throughout the process. Nine averages from first-order braids and three averages from second-order braids were compiled in an excel data sheet for six blocks of braiding experiments. A total of 54 first-order and 18 second-order load cell measurements were used to determine the reported average and standard error of the braiding tension. Videos of the braid process from a vertically mounted high-definition camera were successfully collected for almost all of the braiding trials. Battery depletion and memory capacity errors corrupted 3 first-order and 1 second-order braiding video. For each video, ten randomly spaced time points were selected in which the finger performing a fiber twist was perpendicular to the camera field of view. Angles
were defined with the vertex at the point where two fibers met on the braid axis, and the reference points where the free ends of the fibers wrapped around the finger (figure 6). Ten angle measurements were averaged to determine the overall braid angle for each trial. A total of 51 first-order and 17 second-order braid angle measurements were used to determine the reported average and standard error of the braiding angles. Angle thresholds were set at 20 and 45 degrees to ensure ideal toe region and cell alignment with the axis of strain. The tension threshold was determined to be 0.10lb to prevent permanent deformation of the fibers during braiding. For a complete list of tension and angle measurements, refer to Appendix B. The braid angle was 31.6° ± 3.12° for first-order braids and 40.6° ± 2.69° for second order braids. Braiding tension for both first and second-order braid trials was 0.03lb ± 0.02lb.

Environmental scanning electron microscope images were taken at 10 randomly spaced locations on each of the braiding blocks prior to cutting samples of various sizes for additional tests. A total of 60 images were taken, with 2 to 3 measurements of the pore openings on each image. Figure 7 shows a braid from block 1 with sample measurements, braid images from four additional braiding trials, and a scanning electron micrograph of rabbit ACL collagen for visual comparison of the wavy structure and consistency between braids. Pore sizes from 139 measurements averaged 178.9μm ± 20.1μm, which was directly within the target range of 150 to 250μm. A porosimeter was not available locally to collect porosity data, this information is being sent in from Tsinghua University for inclusion in the final manuscript.

3.2 Mechanical Properties:

12 samples (3 each) from blocks 2 through 5 were subjected to uniaxial tensile failure tests. The original length of the sample was defined as the space between the clamp jaws holding
the ends of the sample. The cross-sectional area of the samples was calculated using ImageJ particle analysis of axial slices taken from NanoCT (figure 8). The average cross-sectional area was averaged from 20 axial slice measurements and found to be \(0.25 \text{mm}^2 \pm 0.08 \text{mm}^2\). One sample failed early in the elongation process by an avulsion of some fibers from the clamp jaws. The 11 remaining successful trials were used to determine the averaged values. Engineering stress and strain were calculated from the force elongation data by dividing the force by the cross-sectional area and the elongation by the original sample length (Figure 9). Figure 10 is a plot of the collective average stress/strain values with the toe region expanded to show the non-linear transition to the elastic region. The ultimate tensile strength and maximum strain were both higher than native tissue and literature data, with values of \(51.6 \text{MPa} \pm 17.1 \text{MPa}\) and \(73.6\% \pm 14.3\%\), respectively. This increase is desirable and will allow some room for the fiber to degrade during ligamentization without risking failure at physiological loading levels. The toe region and elastic modulus, which are environmental conditions that affect cell-material interactions, were directly within the target range of the native ACL. The elastic modulus averaged \(227.5 \text{MPa} \pm 49.5 \text{MPa}\), which matches the correlation to native tissue achieved in current literature. Our greatest improvement over current scaffold designs was the toe region, which was shown to be too high in other designs. The second-order triple helix design has an average toe region of \(3.3\% \pm 1.6\%\), which lies directly in the center of the \(2\) to \(4.8\%\) range found in native tissues.

*Figure 8: NanoCT DICOM slice with individual fibers highlighted*

*Figure 9: Stress/strain information graph for a single sample, 4 blocks of 3 samples each were considered in final results.*
3.3 Biocompatibility:

Qualitative live/dead images were obtained from control and braid samples from blocks 5 and 6. Figure 11 shows images of live/dead stained samples at 1, 7, and 14 days from left to right. Quantitative analysis was not performed due to non-ideal image quality. The confocal microscope used to capture the images was obtained three weeks before the end of the project. While image quality improved with each use, phase artifacts in earlier images interferes with proper cell counts using ImageJ. Visual analysis confirms that cells are attached and aligned with the fiber axes. The cells penetrate into the scaffold contours, but only penetrate a short depth into the fibers. This confirmed that the cells desire the large pores produced by the overlapping fibers, while the pores within the fibers are too small to promote deep penetration of the fibroblasts. This feature may ensure that enough space is left between fibroblasts to permit vascularization of the tissue in-vivo. Cell death increases with prolonged culture, which we suspect is due to overpopulation of the scaffold [21]. Another set of studies using a lower seeding density will be conducted in the summer to improve upon this limitation. Additional images can be found in Appendix B.

AlamarBlue data was collected from 4 control and 8 braid samples at 1, 7, and 14 days. The cells show a logarithmic growth pattern that appears to level off at some maximum within the two-week growth period. Differences in color shift from blue to pink can be seen visually (figure 12), with obvious differences between control and braid samples. Quantification of these
results were calculated by using a standard curve to find fluorescent intensity units per cell, determination of total cells by fluorescent plate readings at each time point, and normalization by an estimated seeding surface area. Standard curves and plate reading results are included in Appendix B. These results support the claims from the live/dead analysis, and overpopulation after initial seeding is again the suspected cause of these growth patterns. Additional tests will validate a more appropriate seeding density, but some encouraging characteristics appear in the growth kinetic curves (figure 13). The initial slope of the curves between days 1 and 7 show an increased growth rate on the braided samples compared to controls. Statistical analysis of the results was conducted by single factor Anova tests, which are displayed in the caption below figure 13. The cell populations at day 1 were not statistically significant, which indicates that there was no difference between the initial populations on the control and braid samples after removal from the seeding vehicles. Meanwhile, populations at days 7 and 14 show statistically significant differences between braided samples and controls. Reduction of the initial seeding density may further enhance these results by producing a much more obvious separation between cell populations.

Figure 12: Samples submerged in 10:1 solutions of standard media and AlamarBlue. Cell populations are calculated from reduction of the oxidized blue solution, which increases its fluorescence intensity. Controls are marked with a C, samples are numbered.

Figure 13: Normalized growth kinetics from AlamarBlue plate readings. Day 1 (P<0.06), Day 7 (P<0.001), Day 14 (P<0.001)
4. Conclusions: The ACL presents and ideal model for ligament tissue engineering due to its high rate of injury in young athletes. Current surgical approaches have high rates of success but suffer from inherent limitations in harvest site morbidity and differences between tendons and ligaments. Tissue engineering can solve these problems by creating a biomimetic environment that encourages seeded fibroblasts to form a ligamentous extracellular matrix. Current scaffold designs are difficult to compare due to a lack of consistency between characterization methods preferred by biologists and bioengineers. This research proposed a novel design using electrospun PCL fibers that mimics the wavy structure of native ligaments by following the hierarchal structure of collagen found within those tissues. A set of short-term protocols was developed to analyze the structural, mechanical, and biocompatibility properties of the scaffold samples. Results support the validity of these tests as well as their ability to be completed in less than 20 days. The proposed scaffold met all of the requirements of the key parameters for a successful ligament tissue scaffold, with a significant improvement of the toe region compared to data from current literature. Biocompatibility results demonstrate success of the scaffold, but may be further improved by reducing the seeding density on the samples. The success of the scaffold warrants further studies with long-term cultures using mechanical stretch & twist bioreactors and targeted growth factors that will elicit ECM synthesis from seeded fibroblasts.

5. Acknowledgements: The authors would like to thank our advisers and collaborators for their expert advice, assistance with data collection and filtering, and access to their expensive analytical equipment at no charge. Without them, these experiments would not have been possible, and would have cost us well more than our $1000 budget:
Lawrence Technological University Faculty Research Seed Grant
Dr. Kevin Baker – Orthopaedic Research Laboratory, Beaumont Health System
Dr. Joseph Corey - University of Michigan Dept. of Neurology
Samuel Tuck – University of Michigan Dept. of Neurology
Basma Khoury – University of Michigan Dept. of Orthopaedic Research
Dr. Robert Wiseman – Michigan State University Dept. of Physiology
Dr. Hsiao-Ping Moore – Dean, College of Arts & Sciences, Lawrence Tech Univ.
Prof. Kenneth Cook – Lawrence Tech University Dept. of Engineering Technology
Dr. Julie Zweisler-Vollick – Lawrence Tech University Dept. of Natural Sciences
Martha Thompson – Lawrence Tech Univ. Dept. of Electrical and Comp. Eng.
Dr. Eric Meyer, Dr. Mansoor Nasir, Joseph Seta, Emily Boggs, Manan Patel, & Ahmad Arabi – Lawrence Tech University Biomedical Engineering Program
Elizabeth Schoenbeck – Computed Tomography Technologist RT (R)(CT)
Dr. Hongjie Wang – Xi’an Jiaotong University Dept. of Materials Science & Engineering
6. References:


Appendix A: Protocols Archive

I. Braid Angle & Tension / Braid Sampling............... 18
II. Environmental Scanning Electron Microscopy......... 20
III. NanoCT / MicroCT / Porosimmetry.................. 21
IV. Tensile Failure Testing / Stress & Strain............ 22
V. Cell Culture / Biocompatibility Assays............... 25

I. LTE Scaffold Project – Protocols: Fiber Braiding Analysis

Materials:

9 meters of electrospun Poly(ε-caprolactone) nanofibers cut into 33cm segments
Fiber braiding clamp (Custom made aluminum blocks on 10”x10” mount plate)
Uniaxial roller bearing guide (Custom made aluminum plates with THK track rollers)
Loadstar iLoad-F (50 lb) load cell with tension adapter
Loadstar DQ-1000U USB interface with cable
Loadstar iLoad software CD
Nikon J1 high definition digital camera w/ 10-100 mm lens
Vertical Camera Mount (Custom made mechanical track and rotator cuff)
Kinovea motion analysis freeware (download from www.kinovea.org)
Fujitsu Lifebook T Series tablet laptop
Microsoft Excel
One sheet of plexiglass (at least 12” long)
Biocompatible silicone epoxy – room temperature vulcanizing (RTV)
Scissors
Procedures:

Braided Scaffold Fabrication

1. Mount the fiber braiding clamp to the roller guide (Figure 14)
2. Mount the load cell to the roller guide extension wall (custom-made)
3. Fix the clamp to the load cell using a wing nut and string such that the clamp mount is centered on the load cell (Figure 15)
4. Prop the load cell side of the roller guide on a textbook, binder, or block of wood to overcome the static friction of the roller system.
5. Open iLoad software and designate an excel file for braiding tension data output.
6. Clamp the ends of three pleated fibers (stacked vertically) between the clamp jaws.
7. Position camera so that field of view is perpendicular to the braid axis.
8. Tare the load cell to compensate for the gravitational load of the clamp.
10. Braid fibers using an overhand method (like braiding hair).
11. Stop recordings when braiding is finished.
12. Use string to secure the free end of the braid.
13. Snip the excess fibers from the free end of the braid (pinch the braid to secure it).
14. Use string to secure the clamped end of the braid.
15. Unclamp the braid and snip the three excess ends of the fibers.
16. Repeat steps 6 through 15 to produce 9 braided fiber subunits.
17. Repeat steps 6 through 11, 13, and 14 to produce 3 double-triple helix braids.
18. Keep single fiber clippings as controls.

Scaffold Sample Preparation:

1. Place one double-triple helix on a piece of plexiglass. The ends should be secured with string.
2. Tie two strings 2mm apart to divide each braid sample into one 6cm sample, one 3cm sample, and 6+ 1cm samples.
3. Cut the samples with scissors after all sample increments have been secured with string.

Braid Tension Measurement Analysis

1. Open the iLoad data *.CSV file in Microsoft excel.
2. Use excel to condense noisy load cell data into discreet data points via signal averaging (~20 samples/data point)
3. Compute the mean value and standard deviation of the data points to determine the average tension applied during the entire braiding process.
4. Repeat steps 1 through 3 for each subunit and completed double-triple helix.

Braid Angle Measurement Analysis

1. Open Kinovea software and select a video file from the Explorer tab.
2. Use arrow keys to advance the video frame-by-frame and take 10 angle measurements.
   Target frames that immediately follow a twist of two individual strands, when the finger performing the twist is perpendicular to the field of view.
3. For each frame of interest, select the angle measurement tool (green triangle on the quick selection bar under the video frame) and click anywhere on the screen.
4. Using the grab & drag tool (auto-selected after placing angle) Place the vertex of the angle at the point where the fibers connect (at the clamp or on the braid) and the two measurement ends where the fibers meet the finger tip. Record the angle measurement with the time on an excel sheet.
5. Compute the mean value and standard deviation of the data points to determine the average braid angle during the entire braiding process using excel.

II. LTE Scaffold Project – Protocols: Scanning Electron Microscope

Materials:
Quanta FEG450 Environmental Scanning Electron Microscope
Uncut braided nanofibers or several of the longer samples if cutting was conducted before ESEM.

Procedures:

1. The ESEM is stored in High Vacuum mode, with the SEM control software open.
2. Click ‘Vent’ in the upper right corner and wait until the chamber status indicator turns grey.
3. Open the vacuum chamber and place the braided sample over the center of the stage. Begin with one end and wrap the excess braid next to the stage to prevent it from coming into contact with any of the moving components.
4. Carefully close the chamber door and select the ‘Low Vacuum’ radio button in the upper right corner of the control screen. Use the drop-down menu to set the chamber pressure to 0.38-0.45 Torr and click select Pump>No Accessory>OK.
5. While the vacuum chamber vents, check to make sure that the beam energy level is set to 10.00 kV and the spot size is 3.5.
6. Use the mouse roller button (click and hold) on the stage view screen to drag the stage up to the 10mm line on the screen.
7. When the chamber status indicator turns green the ‘Beam On’ button to the right will illuminate. Turn the beam on.
8. Select one of the viewing quadrants and un-pause the window using the toolbar at the top.
9. Set the magnification to 20x by double-clicking the magnification quantity above the slider bar to the right. Auto-adjust the brightness, contrast, and focus using the toolbar and locate the end of the sample.
10. Select an area on the sample that shows a maximum number of braid twists and center the field of view over the region.
11. Increase the magnification to 100x, change the sampling time to 3 microseconds, and use the fine adjustment knob to attain the best possible resolution of the sample. Decrease the magnification to 50x.
12. Change the sampling time to 30 microseconds (the snapshot collection rate) and use the toolbar to access the videoscope. Adjust the brightness and contrast such that the average level of the signal is centered on the bottom half of the range and the amplitude peaks are maximized between the top and bottom cut-offs.
13. The image should now be ready – change the title label by double clicking in the appropriate area on the window and take a snapshot. Save the snapshot as an 8-bit TIF file.
14. Repeat the image procedure for 9 more points spread out along the length of the entire braid, this will require two repetitions of steps 1-13 to adjust the sample until the entire length has been imaged. Remove the sample and return the ESEM to High Vacuum Mode when finished.
15. Open each image and use the measuring tool to take qualitative measurements of the pore openings where the fibers overlap, save the measured images as JPEG files.
16. Compare the fiber pattern to SEM images of collagen to validate the architecture.

III. LTE Scaffold Project – Protocols: NanoCT, MicroCT, & Porosimetry

Materials: 2x 1cm Fiber Braid Samples, 2x 1cm Control Samples
NanoCT (GE Nanotom) data collected at University of Michigan
MicroCT (GE Exaview) conducted at Michigan State University
Porosimeter (Make&Model Unknown) data collected at Tsinghua University

Combined Data Analysis:

1. Shipped each of the braid and control samples to nanoCT (Block 1) and collected remaining samples (Blocks 2 through 6) with microCT for availability reasons.
2. Obtain NanoCT DICOM files of 2D lateral cross sections obtained in accordance with local protocols.
3. Obtain Porosimeter results for pore size distribution and average surface area/cm
4. Open Image J freeware program downloaded from (rsbweb.nih.gov)
5. Select File>Open. The DICOM files should be organized into a labeled sequential stack of cross-sectional images. Divide the total number of files by 11, then round off and select the first image of that increment (ie. 2237 images gives an increment of 200, Image 200,400,600…etc are selected for cross-section measurements)
6. Select Process>Enhance Contrast, Saturated Pixels: 10%, all radio buttons deselected>OK
7. Select Image>Adjust>Threshold, All radio buttons unchecked, Default, B&W. Drag the right hand threshold to the far right (bottom toggle bar), then adjust the left hand threshold (top toggle bar) until only the last 10% of the histogram is within the threshold. Select Set>OK and close window.
8. Select Process>Binary>Make Binary
9. Using the freehand selection tool (heart shaped button), use a mouse or tablet pen to outline one entire braided fiber sample. This limits noise pixels from being included in the area measurement.
10. Select Analyze>Analyze Particles, Size 0.00-0.001 mm^2, Circularity 0-1, Show Outlines, Radio Buttons ‘Display Results’ and ‘Summarize’ should be checked. Select OK
11. Use the new drawing to verify a good capture of the fiber constituents, record the total area from the summary window on an excel sheet.
12. Repeat steps 5 through 11 until a minimum of 10 measurements have been made for each fiber sample. Calculate the average cross sectional area between all measurements and apply this measurement to the MTS results to calculate the engineering stress/strain relationships.
13. Compile Porosimeter results into a table showing measurements and averages for all samples.
14. MicroCT DICOM files can be generated using MicroView software available free from GE’s support site. Analysis follows the same procedure as NanoCT. (Note: due to image quality loss, accurate cross sectional area measurements were not obtainable at pixel dimensions of 27μm from microCT – though measurements indicated consistency between samples. NanoCT measurements were much more accurate, with pixel dimensions of 2μm)

IV. LTE Scaffold Project – Protocols: Mechanical Tests

Materials:
Insight Electromechanical Testing System – 5kN, Standard Length
TestWorks4 Software
>5cm samples of braided nanofibers
Procedures:

1. Prepare braided fiber samples by gluing the ends between a glass slide and a metal rod to fit into the MTS clamp jaws
2. Double-click on the TestWork 4 icon on the computer’s desktop
3. Opening a testing method
   a. Once logged in, the Open Method dialog will appear.
   b. Use the pull-down arrow to find the specific method to run.
   c. Click on Tensile Ultimate Failure.
4. Calibrating the device
   a. Click on the file menu option Tools then highlight Calibrate
   b. The Device Calibrate dialog will appear. Select the channel the device is connected to then select the correct device in the Devices window.
   c. Click on Calibrate.
5. Meter reset
   a. TestWork 4 reassign the current value that is read to zero, zero or tare a data channel before running a test so that the test will begin with the value of zero.
   b. Locate the meter for the channel on the test window.
   c. Right- click within the meter and select zero channel.
   d. Never zero or tare a load channel after inserting a test specimen into the fixture. Doing so may result in artificially low readings
6. Choose cell load
   a. Click on Edit, go to Method
   b. Choose Limit Detection, load limit, Default Value
   c. Change Fail to 250N
7. Mount the specimen
   a. Place rods and sample into a MTS clamp in the MTS machine
   b. Make sure the sample is lined up straight and not twisted
   c. Measure the distance between the two clamps (sample length) with a caliper
8. Starting test
   a. Click on the Green Arrow icon button to start the program
   b. You will be prompted to input data:
      i. Fiber Gage Length
      ii. Pre-load Rate
      iii. Pre-load Stop load
      iv. Test Speed
   c. You can get the parameters needed for your test by using a program to calculate your input data (only need to input your mounted sample length)
   d. 2.5% strain/ sec is used in this test
   e. Edit the appropriate information and click ok.
f. Execution of physical test will begin once all required inputs are edited

9. Save data
   a. Click review tab, choose test
   b. Highlight file export preview, click specimen
   c. Click file and then save
   d. Change to .CSV file to be able to open it in Excel.

Analysis of data point outputs:

1. Obtain the averaged cross-sectional area of the fibers obtained from DICOM files from outsourced Nano- or Micro-CT lateral slices.
2. The outputs form the MTS are saved as CSV files for use with Microsoft excel
3. The load shows an incremental increase from 0 to through the end of the study, but the extension reading may begin at some negative value. The CSA is also unknown at this point in time so the output stress/strain data is invalid as it appears.
4. Start a new set of columns on the spreadsheet and produce the following data points for graphing and analysis:
   a. Corrected extension by adding the initial negative value to every extension data point such that the extension begins at 0 and increases to the failure value
   b. Corrected strain by dividing each extension value by the original length of the sample as measured before starting each mechanical test. ($\varepsilon = dL/L_0$)
   c. Calculated stress by dividing the load reading by the average CSA for each data point ($\sigma = F/CSA$)
5. Scroll through the data to find the maximum strain and ultimate tensile strength for the study. Average the values across all tested samples.
6. Plot the entire study by selecting the strain and stress columns and clicking Insert>Scatter>Scatter with only markers. Determine a point where the fibers began to fail as indicated by a sharp drop in stress after the highest stress point on the study (the first failure may be before the ultimate stress point.
7. Select the series of data points that begins at 0 and ends shortly after the failure that follows the ultimate stress point, and create a new scatter plot. Adjust the scales, values, gridlines, titles, and size of the graph to determine the inflection value of the toe region. Record the strain value of the inflection point. Determine the second inflection point where the sample began to yield using the same method.
8. Select the series of data points beginning with the toe-elastic inflection and ending with the elastic-yield inflection and create a new scatter plot. Use a linear trend line to determine the elastic modulus (slope) of the sample. The $R^2$ value should be >0.994 for an accurate linear estimation.
V. LTE Scaffold Project – Protocols: Biocompatibility Assays

Materials:
Silicone elastomer (PDMS) prepolymer & crosslinker, Human Fibroblasts, Test tubes (2, 15, 50 mL sterile), Micropipettes, Automatic Pipette, gloves, safety glasses, DMEM powder or liquid stock, Fetal Bovine Serum, Pen/Strep, 1X Sterile Phosphate Buffer Solution, 100mm and 35mm culture plates, 24 well plates, 96 well plates, Microscope slides and cover slips.

20G Centrifuge, Heracell Incubator, Hemacytometer, Nikon light microscope, Zeiss Axioview Fluorescent Microscope with AxioCam and Axiovision Software, Sterigard Bio-safety hood, Vortex Mixer, -70°C and -20°C freezers, Plate reader, Invitrogen Calcien/Ethidium Homodimer 1 stains, Invitrogen AlamarBlue reagent, 1 cm fiber samples (6 control, 12 braided)

Stock Culture:

1. Warm up or obtain fresh suspension of human ligament fibroblasts (we used periodontal FBs)
2. Seed a minimum of 100,000 cells onto a 100mm culture plate.
3. Prepare a stock volume (0.5L) of Dulbecco’s modified eagle medium with 10% fetal bovine serum and 1% penicillin/streptomycin.
4. Add medium to obtain a final volume of 10ml in the stock plate.
5. Incubate cells at 37°C, 5% CO₂, exchange media 24 hours after seeding, then every 48 to 72 hours afterward. Aspirate media and pipette 10 ml fresh media from stock to exchange.
6. Cells will reach confluence in approximately 1 week at a population of around 1 million cells. Use 100,000 cells to start a new passage of the stock, and the remaining cells for sample seeding.
7. Record passage date and number on plate lid. Follow cell seeding procedures for both stock plates and samples.

Sample vehicle preparation:

1. Prepare 26.4 grams of PDMS solution at a 10:1 pre-polymer to crosslinking agent ratio.
2. Pour ~1g PDMS into each well of two 6 well plates. (One plate for LiveDead, another for AlamarBlue)
3. Degas PDMS in a desiccator for 1 hour
4. Press pieces of plastic scrap into PDMS to form two 0.5x1.5 cm channels. Incubate overnight in a furnace at 65°C
5. Gently separate scraps from sample wells, insert a fiber control or braided fiber sample into each channel (2 controls, 4 braid samples in at least 3 plates, 1 for live/dead and 2 for AB)
6. Before seeding, soak entire plate with samples in ethanol for a minimum for 2 hours.

Cell Seeding:
1. Thoroughly aspirate ethanol from sample vehicle plate and wash four times with sterile phosphate buffer solution.

2. Check stock culture plate for confluence, aspirate media and wash cell monolayer once with 2ml sterile PBS. (Verify volume needed to just fill each channel, we used 500 μl)

3. Add 2ml trypsin to stock plate, incubate at 37°C for 3 minutes, then tap bottom of plate several times to ensure thorough separation of cells.

4. Using a pipette, cycle cell suspension up and down around the bottom of the well to capture as many suspended cells as possible.

5. Pipette entire suspension into a 15ml test tube. Immediately add 4ml fresh media to neutralize trypsin.

6. Centrifuge at 20G for 5 minutes to spin-down cells into a dense pellet.

7. Aspirate a majority of the supernatant and add 2ml fresh media. Re-suspend cells by gentle tapping of the tube.

8. Using a P20 pipetter, obtain a 10μl aliquot of cell suspension by pipetting up and down several times, inject into hemacytometer via capillary action.

9. Count cells on all four quadrants and calculate the number of cells/ml in suspension using the following formula:
   \[
   \text{#Cells} \times 10^4 = \text{Total cells in 2ml}
   \]

10. Calculate suspension dilution volume to obtain a cell density of 100,000 cells per sample. Allot 100,000 cells to continue passage of stock plate. Follow ‘Stock Culture’ steps for stock plate.

11. Pipette cell suspension into sample channels; incubate for 24 hours in vehicle plates at 37°C.

12. Using sterile tweezers, transfer controls and samples to each well of a 24 well plate. Use two rows of wells for Live/Dead samples and two rows for AlamarBlue samples (2 control, 4 braided). Use the final empty row for negative controls with AlamarBlue.

13. Add 750μl fresh media to new plate wells, incubate using same media exchange scheme as the stock culture. Run live/dead and AlamarBlue assays at one week and two week time points.

**Live/Dead Assay**

1. Remove Ethidium Homodimer and Calcein from freezer and allow to warm to room temperature. Cover stock vials and an empty 15ml tube with aluminum foil. Prepare all solutions in low-light conditions whenever possible.

2. Add 4μl 2mM EthD-1 to 2ml sterile PBS and vortex for thorough mixing

3. Add 1μl 4mM Calcien to EthD solution and vortex. Solution is usable for 24 hours.

4. Start confocal microscope and ensure that the machine is prepared to take adequate micrograph exposures before initiating staining. (You’ll be sorry otherwise, we promise)

5. Wash samples twice with 37°C sterile PBS.
6. At each time point, add 500μl stain solution to one control and braid sample well (one at a time). These samples will be sacrificed after imaging, with one set of backup samples.
7. Incubate the stained sample for 15 minutes, remove from solution and add next volume of staining solution to the next sample until finished. The sample is valid for about 45 minutes before false dead samples and live phase noise begin to interfere with image analysis.
8. Fix control fibers to a microscope slide using mounting media and a cover slip, press very gently to smooth sample. Braid samples can be viewed in a confocal microscope by cutting a hole in a 35mm dish lid and epoxying a cover slip to the bottom. Wet samples with sterile PBS as needed.
9. Mount slide on a confocal microscope, use Alexafluor 488 and 566 filters to capture both live and dead images at equal locations along the sample. Phase images of the fibers can be overlayed with live/dead stacks using fluoview software (software operation requires training and practice).
10. Validation tests may be necessary to determine an appropriate seeding density. Follow the preceeding Live/Dead and following AlamarBlue protocols for samples of 10,000, 20,000, and 50,000 if 100,000 seems too dense.

AlamarBlue Assay (Allot 7 to 8 hours for each time point study)

1. Add 600μl AlamarBlue stock reagent to 6ml fresh media.
2. Add 700μl of the solution to eight wells of a fresh 24-well plate.
3. Using sterile tweezers, transfer two control samples and four braid samples to six of the prepared wells. Use the two empty wells as negative controls.
4. Incubate for 6 hours at 37°C.
5. Pipette two 150μl aliquots from each of the eight wells into sixteen wells of a clear, flat-bottom 96 well plate. Make a bock diagram for the sample number and plate locations for data collection. Repeat for a blackened fluorescence plate if possible.
6. Measure fluorescence (excitation @545nm, emission @590nm) if possible. If the plate-reader is not capable of fluorescent analysis, measure absorbance at 570nm and 600nm.
7. Plot the cell population using standard curve reductions of the alamarblue reagent in accordance with the provided alamarblue assay instructions for either absorbance or fluorescence using Microsoft excel (Invitrogen Protocols).
8. Verify reduction by using provided formulas and negative controls. Calculate the cell populations on positive controls and braid samples using formulas provided with AlamarBlue instructions.
Appendix B: Data & Images Archive

U. Braid Angle & Tension Data Sheets…………………………. 29
W. ESEM Images with Pore Measurements…………………….. 36
X. NanoCT / MicroCT / Porosimmetry Data Sheets………………. 56
Y. Tensile Failure Testing / Stress & Strain Data Sheets……… 70
Z. Live/Dead Confocal Images & AlamarBlue Data Sheets….. 96